Lectures 5 and 6: Engineering Tools: Spreadsheets

C. Schaefer

Department of Electrical and Computer Engineering

George Mason University
Administrivia

• The lecture slides are taken from Cengage Learning Engineering and, except where otherwise noted, are the copyright of Cengage (publisher of your book).

• Homework:
  – Read Chapter 14
  – You will need Microsoft Excel (or OpenOffice) to complete your homework assignment. If you don’t own a copy, please complete your assignment in one of the many campus computer labs.
  – Use two separate worksheets, one for each homework problem, saved to a single workbook with the following file name nomenclature:
    • J_Smith_G1234_HW2 (first name initial; underscore; last name; underscore; the letter G followed by the last four digits of your G#; underscore; HW2)
    • Include your full name, G #, date, and Problem # in the upper left hand portion of each worksheet. Name each worksheet with the appropriate Problem #.
  – Email me your homework before the start of class on September 27th.
  – Bonus points for well-formatted, “clean” spreadsheets.
• Today’s Impromptu Design Project
  – Problem 3.11 in Chapter 3.
  – Two minor differences:
    • You will be provided 6 feet of aluminum foil
    • The boat must fit within a 8” x 6” rectangle (no height restriction)
    • I will bring the pennies and the tub to test your designs.
    • You will have 20 minutes to complete your boat so begin thinking of a design
Computational Engineering Tools

Using Available Software to Solve Engineering Problems:

• Electronic Spreadsheets
• MATLAB
In this chapter we will

• discuss basic makeup of Microsoft Excel
• explain how a spreadsheet is divided into rows and columns, and how to input data or a formula into an active cell
• explain the use of other tools such as Excel’s mathematical, statistical, and logical functions
• explain how to plot results of an engineering analysis
Objectives

The objective of this chapter is to introduce the Excel spreadsheet, which is commonly used in solving engineering problems.
Microsoft Excel – an Electronic Spreadsheet

• A tool that can be used to solve an engineering problem
• Used to solve simpler engineering problems instead of using computer programs
• Commonly used to record, organize, and analyze data using formulas
• Used to present results of an analysis in chart form
Naming Worksheets

Double click this tab, type the name, hit the Enter key
Moving Worksheets

Hold down the left button on the mouse and drag the tab to the desired location.
Cell and Address

Cell – represents the box that one sees as the result of the intersection of a row and a column

What you type in formula bar

What you get in active cell

Cell C4
Moving a Cell

Move content in cell A5 to cell C8

Move the mouse over cell A5 until the pointer becomes a circular arrow with an arrowhead. While holding down the left button, drag the mouse until the content of A5 is in C8. Release the mouse button.
Range – cells that are selected simultaneously

After the range is selected, click the “name box” and type the name of range

Click on A3, drag the mouse while pressing down the left button to the last cell in the range B10
**Inserting Cells**

At Home... click on Cells

select Insert, then Insert Cells...

select shift cells down

cells inserted

select the cells where the new cells are to be inserted
Inserting Columns

select the column(s) where the new column(s) is to be inserted

At Home
select Insert Sheet Columns

click on Cells

column inserted
Inserting Rows

1. Select the row(s) where the new row(s) is to be inserted.
2. At Home, select Insert Sheet Rows.
3. Click on Cells.
4. Select Insert.
5. Rows inserted.
Creating Formulas in Excel

Basic Excel Arithmetic Operations

<table>
<thead>
<tr>
<th>Operation</th>
<th>Symbol</th>
<th>Example: Cells A5 and A6 contain the values 10 and 2, respectively</th>
<th>Cell A7 contains the result of the formula given in the example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Addition</td>
<td>+</td>
<td>=A5+A6+20</td>
<td>32</td>
</tr>
<tr>
<td>Subtraction</td>
<td>−</td>
<td>=A5−A6</td>
<td>8</td>
</tr>
<tr>
<td>Multiplication</td>
<td>*</td>
<td>=(A5*A6)+9</td>
<td>29</td>
</tr>
<tr>
<td>Division</td>
<td>/</td>
<td>=(A5/2.5)+A6</td>
<td>6</td>
</tr>
<tr>
<td>Raised to a power</td>
<td>^</td>
<td>=(A5^A6)^0.5</td>
<td>10</td>
</tr>
</tbody>
</table>
Example 14.1 – Creating Formulas

Given: standard air using the ideal gas law
where
\[ P = \text{standard atmosphere pressure} = 101.3 \text{ kPa} \]
\[ R = \text{gas constant for air} = 286.9 \]
\[ T = \text{air temperature in Kelvin (K)} \]

Find: use Excel to create a table that shows the density of air as a function of temperature in the range of 0°C (273.15 K) to 50°C (323.15 K) in increment of 5°C.

\[ \rho = \frac{P}{RT} \]

\[ \rho = \frac{101300 \text{ Pa}}{286.9 \frac{J}{\text{kg} \cdot \text{K}} \left( T + 273 \right) \text{K}} \]
Solution:

Substituting the values of R and P in the standard gas law yields,

\[ \rho = \frac{101300 \ \text{Pa}}{286.9 \ \frac{\text{J}}{\text{kg} \cdot \text{K}} (T + 273) \ \text{K}} \]

Now we can use the above equation to create the table in Excel.
Example 14.1 – Creating Formulas (continued)

1. In cell A1, type **Density of air as a function of temperature**

2. In cells A3 and B3, type **Temperature (C)**, **Density (kg/m³)**, respectively.

3. In cells A5 and A6, type **0** and **5**, respectively.
Example 14.1 – Creating Formulas (continued)

4. Pick cells A5 and A6 and use the fill command with the + handle to copy the pattern into cells A7 through A15.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Density of air as a function of temperature</td>
</tr>
<tr>
<td>1</td>
<td>Temperature (C)</td>
</tr>
<tr>
<td>2</td>
<td>Density (kg/m³)</td>
</tr>
<tr>
<td>3</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>0</td>
</tr>
<tr>
<td>6</td>
<td>5</td>
</tr>
<tr>
<td>7</td>
<td>10</td>
</tr>
<tr>
<td>8</td>
<td>15</td>
</tr>
<tr>
<td>9</td>
<td>20</td>
</tr>
<tr>
<td>10</td>
<td>25</td>
</tr>
<tr>
<td>11</td>
<td>30</td>
</tr>
<tr>
<td>12</td>
<td>35</td>
</tr>
<tr>
<td>13</td>
<td>40</td>
</tr>
<tr>
<td>14</td>
<td>45</td>
</tr>
<tr>
<td>15</td>
<td>50</td>
</tr>
</tbody>
</table>
Example 14.1 – Creating Formulas (continued)

5. In cell B5, type the formula
   \[(101300)/((286.9)*(A5+273))\]

Result of formula

© 2011 Cengage Learning. All Rights Reserved.
Example 14.1 – Creating Formulas

(continued)

Select the Fill icon

At Home menu

6. Select range B5 to B15

Select Down to copy formulas to cells B5 to B15

Resulting density

© 2011 Cengage Learning Engineering. All Rights Reserved.

ENGR107 – Engineering Fundamentals
Example 14.1 – Creating Formulas (continued)

7. At Home menu, click Number button

Or use decimal icon to reduce # of decimal places

Select “Number”

Click on Number tab

Select Number of decimal places
Example 14.1 – Creating Formulas

(continued)

Final results, cell contents were centered using the **Alignment** button from the **Home** menu.

<table>
<thead>
<tr>
<th>Temperature (C)</th>
<th>Density (kg/m²)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>1.29</td>
</tr>
<tr>
<td>5</td>
<td>1.27</td>
</tr>
<tr>
<td>10</td>
<td>1.25</td>
</tr>
<tr>
<td>15</td>
<td>1.23</td>
</tr>
<tr>
<td>20</td>
<td>1.21</td>
</tr>
<tr>
<td>25</td>
<td>1.18</td>
</tr>
<tr>
<td>30</td>
<td>1.17</td>
</tr>
<tr>
<td>35</td>
<td>1.15</td>
</tr>
<tr>
<td>40</td>
<td>1.13</td>
</tr>
<tr>
<td>45</td>
<td>1.11</td>
</tr>
<tr>
<td>50</td>
<td>1.09</td>
</tr>
</tbody>
</table>

Then, click the **Center** icon.

© 2011 Cengage Learning Engineering. All Rights Reserved.

**ENGR107 – Engineering Fundamentals**
Cell Reference

• When creating formulas, there are 3 ways to address a cell especially if the **Fill** command is used
  – Absolute cell reference
  – Relative cell reference
  – Mixed cell reference
Absolute Reference

• Absolute cell reference does not change when Fill command is used to copy the formula into other cells

• Absolute cell reference is made by $column-letter$row-number, e.g., $A$3

• Formulas will always refer to the content of the absolute cell regardless how the formulas are copied
Absolute Reference (continued)

Note the results of the formulas copied from cell B3.

Absolute cell reference

Content of $A$3

© 2011 Cengage Learning Engineering. All Rights Reserved.

ENGR107 – Engineering Fundamentals
Relative Reference

- Relative reference changes in the formula when the Fill command is used to copy the formula into other cells.
- To make a relative reference, $ sign is not needed in the cell address.
Relative Reference (continued)

The content of cell A3 is 1000, and its formula is 0.06*A7. The fill command was used to copy the formula in cell B3 (0.06*A3) to B4 to B11, resulting in the values shown in the diagram.
Mixed Reference

• Mixed reference can be done in one of two ways:
  – keep column absolute and row relative, e.g., $A3$
  – keep column relative and row absolute, e.g., A$3$
Example 14.2 – Cell Reference

Given: interest rate ranges from 6% to 8% and principle ranges from $1000 to $3000.

Find: Using Excel, create a table that shows the relationship between the interest earned and the amount deposited in increments shown in the table.
Example 14.2 – Cell Reference (continued)

Find (continued):

Relationship between interested earned and amount deposited

<table>
<thead>
<tr>
<th>Dollar Amount</th>
<th>0.06</th>
<th>0.07</th>
<th>0.075</th>
<th>0.08</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000</td>
<td>60</td>
<td>70</td>
<td>75</td>
<td>80</td>
</tr>
<tr>
<td>1250</td>
<td>75</td>
<td>87.5</td>
<td>93.75</td>
<td>100</td>
</tr>
<tr>
<td>1500</td>
<td>90</td>
<td>105</td>
<td>112.5</td>
<td>120</td>
</tr>
<tr>
<td>1750</td>
<td>105</td>
<td>122.5</td>
<td>131.25</td>
<td>140</td>
</tr>
<tr>
<td>2000</td>
<td>120</td>
<td>140</td>
<td>150</td>
<td>160</td>
</tr>
<tr>
<td>2250</td>
<td>135</td>
<td>157.5</td>
<td>168.75</td>
<td>180</td>
</tr>
<tr>
<td>2500</td>
<td>150</td>
<td>175</td>
<td>187.5</td>
<td>200</td>
</tr>
<tr>
<td>2750</td>
<td>165</td>
<td>192.5</td>
<td>206.25</td>
<td>220</td>
</tr>
<tr>
<td>3000</td>
<td>180</td>
<td>210</td>
<td>225</td>
<td>240</td>
</tr>
</tbody>
</table>

Solution:

\[
\text{interest earned} = \left(\text{amount deposited}\right) \times \left(\frac{\text{interest rate (\%)} \times 100}{100}\right)
\]
Example 14.2 – Cell Reference (continued)

Solution (continued):

Type cell formula, note the use of mix reference

Use **Fill** command to copy formula from cell B3 to cells C3:E3

Use **Fill** command to copy formulas from cells B3:E3 to cells B4:E11

<table>
<thead>
<tr>
<th>Dollar Amount</th>
<th>Interest Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>0.06</td>
</tr>
<tr>
<td>1000</td>
<td>60</td>
</tr>
<tr>
<td>1250</td>
<td>75</td>
</tr>
<tr>
<td>1500</td>
<td>90</td>
</tr>
<tr>
<td>1750</td>
<td>105</td>
</tr>
<tr>
<td>2000</td>
<td>120</td>
</tr>
<tr>
<td>2250</td>
<td>135</td>
</tr>
<tr>
<td>2500</td>
<td>150</td>
</tr>
<tr>
<td>2750</td>
<td>165</td>
</tr>
<tr>
<td>3000</td>
<td>180</td>
</tr>
</tbody>
</table>
Excel Functions

• Excel functions are grouped into categories
  – Mathematical
  – Trigonometric
  – Statistical
  – Financial
  – Logical

• Function can be entered in any cell by
  – typing the function name
  – using the Paste Function ($f_x$) button
Excel Function

Click the **Function** button in the **Home** menu

Select a function category

Select function **SUM** for cell E1

Help link

Type in formula with **SUM** function

the answer

© 2011 Cengage Learning Engineering. All Rights Reserved.

ENGR107 – Engineering Fundamentals
### Some Excel Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description of the Function</th>
<th>Example</th>
<th>Result of the Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>SUM(range)</td>
<td>It sums the values in the given range.</td>
<td>=SUM(A1:B10)</td>
<td>164</td>
</tr>
<tr>
<td></td>
<td></td>
<td>or =SUM(values)</td>
<td></td>
</tr>
<tr>
<td>AVERAGE(range)</td>
<td>It calculates the average value of the data in the given range.</td>
<td>=AVERAGE(A1:B10)</td>
<td>8.2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>or =AVERAGE(values)</td>
<td></td>
</tr>
<tr>
<td>COUNT</td>
<td>It counts the number of values in the given range.</td>
<td>=COUNT(A1:B10)</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td></td>
<td>or =COUNT(values)</td>
<td></td>
</tr>
<tr>
<td>MAX</td>
<td>It determines the largest value in the given range.</td>
<td>=MAX(A1:B10)</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td></td>
<td>or =MAX(values)</td>
<td></td>
</tr>
<tr>
<td>MIN</td>
<td>It determines the smallest value in the given range.</td>
<td>=MIN(A1:B10)</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td></td>
<td>or =MIN(values)</td>
<td></td>
</tr>
<tr>
<td>STDEV</td>
<td>It calculates the standard deviation for the values in the given range.</td>
<td>=STDEV(A1:B10)</td>
<td>1.105</td>
</tr>
<tr>
<td></td>
<td></td>
<td>or =STDEV(values)</td>
<td></td>
</tr>
<tr>
<td>PI</td>
<td>It returns the value of π, 3.14159265358979, accurate to 15 digits.</td>
<td>=PI()</td>
<td>3.14159265358979</td>
</tr>
<tr>
<td>DEGREES</td>
<td>It converts the value in the cell from radians to degrees.</td>
<td>=DEGREES(PI())</td>
<td>180</td>
</tr>
<tr>
<td>RADIANS</td>
<td>It converts the value from degrees to radians.</td>
<td>RADIANS(90)</td>
<td>1.57079</td>
</tr>
<tr>
<td></td>
<td></td>
<td>or =RADIANS(D1)</td>
<td></td>
</tr>
<tr>
<td>COS</td>
<td>It returns the cosine value of the argument. The argument must be in radians.</td>
<td>=COS(PI()/2)</td>
<td>3.14159</td>
</tr>
<tr>
<td></td>
<td></td>
<td>or =COS(RADIANS(D1))</td>
<td></td>
</tr>
<tr>
<td>SIN</td>
<td>It returns the sine value of the argument. The argument must be in radians.</td>
<td>=SIN(PI()/2)</td>
<td>-1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>or =SIN(RADIANS(D1))</td>
<td>1</td>
</tr>
</tbody>
</table>
### Additional Excel Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description of the Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>SQRT(x)</td>
<td>Returns the square root of value x.</td>
</tr>
<tr>
<td>FACT(x)</td>
<td>Returns the value of the factorial of x. For example, FACT(5) will return: (5)(4)(3)(2)(1) = 120.</td>
</tr>
</tbody>
</table>

#### Trigonometric Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description of the Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>TAN(x)</td>
<td>Returns the value for the tangent of x. The argument must be in radians.</td>
</tr>
<tr>
<td>DEGREES (x)</td>
<td>Converts the value of x from radians to degrees. It returns the value of x in degrees.</td>
</tr>
<tr>
<td>ACOS(x)</td>
<td>This is the inverse cosine function of x. It is used to determine the value of an angle when its cosine value is known. It returns the angle value in radians, when the value of cosine between −1 and 1 is used for argument x.</td>
</tr>
<tr>
<td>ASIN(x)</td>
<td>This is the inverse sine function of x. It is used to determine the value of an angle when its sine value is known. It returns the angle value in radians when the value of sine falls between −1 and 1.</td>
</tr>
<tr>
<td>ATAN(x)</td>
<td>This is the inverse tangent of the x function. It is used to determine the value of an angle when its tangent value is known.</td>
</tr>
</tbody>
</table>

#### Exponential and Logarithmic Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description of the Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>EXP(x)</td>
<td>Returns the value of ( e^x ).</td>
</tr>
<tr>
<td>LN(x)</td>
<td>Returns the value of the natural logarithm of x. Note that x must be greater than 0.</td>
</tr>
<tr>
<td>LOG(x)</td>
<td>Returns the value of the common logarithm of x.</td>
</tr>
</tbody>
</table>
Example 14.3 – Excel Functions

Given: an Excel worksheet shown in which columns A and B contain the data range which we have named values; cell D1 contains the angle 180.

Find: familiarize yourself with some of the Excel functions used in the cells E1 through E14.

Solution: see Excel functions listed in the next slide
Example 14.3 – Excel Functions

(continued)

E1:  =SUM(A1:B10)
E2:  =AVERAGE(A1:B10)
E3:  =COUNT(A1:B10)
E4:  =MAX(A1:B10)
E5:  =MIN(A1:B10)
E6:  =STDEV(A1:B10)
E7:  =PI()
E8:  =DEGREES(PI())
E9:  =RADIANS(90)
E10: =RADIANS(D1)
E11: =COS(PI()/2)
E12: =COS(RADIANS(D1))
E13: =SIN(PI()/2)
E14: =SIN(RADIANS(D1))
Now and Today Functions

**Now and Today functions**

![Excel screenshot showing the NOW() and TODAY() functions]

**Now and Today function values updated automatically**
**Excel Functions – Example**

*Given:* the water data shown below

*Find:* use Excel to compute the average and standard deviation of the density of water data

<table>
<thead>
<tr>
<th>Group A Findings</th>
<th>Group B Findings</th>
</tr>
</thead>
<tbody>
<tr>
<td>( \rho ) (kg/m³)</td>
<td>( \rho ) (kg/m³)</td>
</tr>
<tr>
<td>1020</td>
<td>950</td>
</tr>
<tr>
<td>1015</td>
<td>940</td>
</tr>
<tr>
<td>990</td>
<td>890</td>
</tr>
<tr>
<td>1060</td>
<td>1080</td>
</tr>
<tr>
<td>1030</td>
<td>1120</td>
</tr>
<tr>
<td>950</td>
<td>900</td>
</tr>
<tr>
<td>975</td>
<td>1040</td>
</tr>
<tr>
<td>1020</td>
<td>1150</td>
</tr>
<tr>
<td>980</td>
<td>910</td>
</tr>
<tr>
<td>960</td>
<td>1020</td>
</tr>
</tbody>
</table>

© 2011 Cengage Learning Engineering. All Rights Reserved.

ENGR107 – Engineering Fundamentals
Solution:

Step 1, type headings

Step 2, type headings

Step 3, type in the density values

Step 4, type AVERAGE

Step 5

B16: =average(B5:B14)

C16: =average(C5:C14)

Step 6, type STAND. DEV.

B18: =stdev(B5:B14)

C18: =stdev(C5:C14)
Excel Logical Functions

• Logical functions allow us to test various conditions when programming formulas to analyze data

• Relational or comparison operators allow us to test relative magnitude of various arguments
# Excel’s Logical Functions

<table>
<thead>
<tr>
<th>Logical Functions</th>
<th>Description of the Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>AND(logic1, logic2, logic3, . . .)</td>
<td>Returns true if all arguments are true and returns false if any of the arguments are false.</td>
</tr>
<tr>
<td>False( )</td>
<td>Returns the logical value false.</td>
</tr>
<tr>
<td>IF(logical test, value_if_true, value_if_false)</td>
<td>It first evaluates the logical test; if true, then it returns the value_if_true; if the evaluation of the logical test deems false, then it returns the value_if_false value.</td>
</tr>
<tr>
<td>NOT(logical)</td>
<td>Reverses the logic of its argument; returns true for a false argument and false for the true argument.</td>
</tr>
<tr>
<td>OR(logical1, logical2, . . .)</td>
<td>Returns TRUE if any argument is true and returns FALSE if all arguments are false.</td>
</tr>
<tr>
<td>TRUE( )</td>
<td>Returns the logical value TRUE.</td>
</tr>
</tbody>
</table>
# Excel’s Relational or Comparison Operators

<table>
<thead>
<tr>
<th>Relational Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;</code></td>
<td>Less than</td>
</tr>
<tr>
<td><code>&lt;=</code></td>
<td>Less than or equal to</td>
</tr>
<tr>
<td><code>=</code></td>
<td>Equal to</td>
</tr>
<tr>
<td><code>&gt;</code></td>
<td>Greater than</td>
</tr>
<tr>
<td><code>&gt;=</code></td>
<td>Greater than or equal to</td>
</tr>
<tr>
<td><code>&lt;&gt;</code></td>
<td>Not equal to</td>
</tr>
</tbody>
</table>
Example 14.5 – Excel Logical Functions

**Given:** the pipeline shown is connected to a control (check) valve that open when the pressure in the line reaches 20 psi. Various readings were taken at different times and recorded.

**Find:** Using Excel’s logical functions, create a list that shows the corresponding open and closed position of the check valve.
Example 14.5 – Excel Logical Functions
(continued)

Solution: Check valve opens when pressure in line reaches 20 psi

Formula using logical function **IF** and relative operator **>=**

Use **Fill** command to copy formula in cell B3 to cells B4 to B10

Type in the values in column A
Plotting with Excel

• Use Excel to create charts such as
  – Histograms (column or bar charts)
  – Pie charts
  – Line charts
  – XY charts
• Most charts we create as engineers are xy-type charts
• Chart Wizard walk you through the necessary steps to create a chart
Example 14.6 – Plotting

Given: the results from Example 14.1

Find: create a graph showing the value of air density as a function of temperature.
Example 14.6 – Plotting (continued)

Solution:

Click Insert tab
Select Chart Wizard icon
Click Scatter plot
Select XY plot with line
Select the data range
Solution (continued): the chart is shown to the right of the data
Example 14.6 – Plotting (continued)

Solution (continued): add axis and chart titles by clicking the Layout tab under Chart Tool menu and make necessary modifications.
Plotting Two Data Sets with Different Ranges on the Same Chart

Temperature as a function of time

Scale for wind speed

Scale for temperature

Wind speed as a function of time
Example 14.7 – Plotting of Two Data Sets

*Given:* an empirical relationship between fuel consumption and car speed is given below. *Note:* \( V \) is the speed of the car if mph and the given relationship is valid for \( 20 \leq V \leq 75 \).

*Find:* plot the fuel consumption and car speed relationship in both miles per gallon and gallons per mile.

\[
\text{Fuel Consumption (Miles per Gallon)} = \frac{1000 \times V}{900 + V^{1.85}}
\]
Example 14.7 – Plotting of Two Data Sets (continued)

Solution (continued):

1. Using Excel and the given formula, compute the fuel consumption in miles per gallon and gallons per mile.

\[ \text{fuel consumption} = \frac{1000 \times A3}{900 + A3^{1.85}} \]

The values are:

<table>
<thead>
<tr>
<th>Speed (mph)</th>
<th>Miles Per Gallon</th>
<th>Gallons Per Mile</th>
</tr>
</thead>
<tbody>
<tr>
<td>20</td>
<td>17.31</td>
<td>0.058</td>
</tr>
<tr>
<td>25</td>
<td>19.45</td>
<td>0.051</td>
</tr>
<tr>
<td>30</td>
<td>20.83</td>
<td>0.048</td>
</tr>
<tr>
<td>35</td>
<td>21.62</td>
<td>0.046</td>
</tr>
<tr>
<td>40</td>
<td>21.98</td>
<td>0.046</td>
</tr>
<tr>
<td>45</td>
<td>22.02</td>
<td>0.045</td>
</tr>
<tr>
<td>50</td>
<td>21.83</td>
<td>0.046</td>
</tr>
<tr>
<td>55</td>
<td>21.50</td>
<td>0.047</td>
</tr>
<tr>
<td>60</td>
<td>21.07</td>
<td>0.047</td>
</tr>
<tr>
<td>65</td>
<td>20.58</td>
<td>0.049</td>
</tr>
<tr>
<td>70</td>
<td>20.05</td>
<td>0.050</td>
</tr>
<tr>
<td>75</td>
<td>19.51</td>
<td>0.051</td>
</tr>
</tbody>
</table>

These values are inverse of those in column B.
Example 14.7 – Plotting of Two Data Sets (continued)

Solution (continued): refer to Example 14.6 to create the chart for the first set of data “Miles Per Gallon”, then go to step 2.

3. Choose Select Data ...

2. right click on Chart area
Example 14.7 – Plotting of Two Data Sets (continued)

Solution (continued): in the Select Data Source,

4. Click on the Add button

5. Type in series name, and choose the Series X values, and Series Y values

© 2011 Cengage Learning Engineering. All Rights Reserved.

ENGR107 – Engineering Fundamentals
Example 14.7 – Plotting of Two Data Sets (continued)

Solution (continued): Format the curve for the second data set

6. Click on the Format button under Chart Tools.

7. Select Series “Gallons per Mile”.

8. Click on the Format Selection icon.

---

© 2011 Cengage Learning Engineering. All Rights Reserved.
ENGR107 – Engineering Fundamentals
Example 14.7 – Plotting of Two Data Sets

Solution (continued): in Format Data Series,

9. Select the Series Options tab,

10. Select the Secondary axis

11. Select Line Style tab

12. Pull down Dash type and make a selection
Example 14.7 – Plotting of Two Data Sets

Solution (continued): add title to the secondary axis

13. Click the Layout tab under Chart Tools menu

14. Click the Axis Titles icon to add title for secondary axis
Solution (continued): Final results
Matrix Computation with Excel

- **Matrix** is an array of numbers, variables, or mathematical terms
- **Size** of a matrix is defined by its number of rows and columns
- We denote matrix by a **boldface letter** in brackets [ ] and { }
Matrix – Definitions

3 by 3 (3x3) matrix

\[
\begin{bmatrix}
\text{6} & \text{5} & \text{9} \\
\text{1} & \text{26} & \text{14} \\
\text{0} & \text{8} & \text{0}
\end{bmatrix}
\]

3 by 1 (3x1) column matrix

\[
\begin{bmatrix}
x \\
y \\
z
\end{bmatrix}
\]

1 by 4 (1x4) row matrix

\[
\begin{bmatrix}
\text{5} & \text{0} & \text{2} & \text{0}
\end{bmatrix}
\]

An element of a matrix

© 2011 Cengage Learning Engineering. All Rights Reserved.

ENGR107 – Engineering Fundamentals
Example 14.8 – Matrix Algebra

Given: matrices

\[
\begin{bmatrix}
  0 & 5 & 0 \\
  8 & 3 & 7 \\
  9 & -2 & 9 \\
\end{bmatrix}
\quad \begin{bmatrix}
  4 & 6 & -2 \\
  7 & 2 & 3 \\
  1 & 3 & -4 \\
\end{bmatrix}
\quad \begin{bmatrix}
  -1 \\
  2 \\
  5 \\
\end{bmatrix}
\]

Find: Use Excel to perform the following operations:

(a) \([A] + [B] = ?\)

(b) \([A] - [b] = ?\)

(c) \([A][B] = ?\)

(d) \([A]\{C\} = ?\)

Read chapter 18 for more detailed discussion on matrix algebra.
Solution: Type in appropriate values and characters for each matrix.

\[
[A] = \begin{bmatrix}
0 & 5 & 0 \\
8 & 3 & 7 \\
9 & -2 & 9 \\
\end{bmatrix}
\quad [B] = \begin{bmatrix}
4 & 6 & -2 \\
7 & 2 & 3 \\
1 & 3 & -4 \\
\end{bmatrix}
\quad \{C\} = \begin{bmatrix}
-1 \\
2 \\
\end{bmatrix}
\]

Note: these are boldface.
Example 14.8 – Matrix Algebra (continued)

Solution (continued): compute \([A] + [B]\)

Type this formula to add \([A]\) and \([B]\), then holding down the Ctrl and the Shift keys press the Enter key.

Type the heading for part (a)

Select the range B9 to D11
Example 14.8 – Matrix Algebra (continued)

Solution (continued): compute \([A] - [B]\); Repeat similar steps to calculate \([A] - [B]\). Use the formula \(=B3:D5-G3:I5\).

\[
[A] = \begin{bmatrix} 0 & 5 & 0 \\ 8 & 3 & 7 \\ 9 & -2 & 9 \end{bmatrix}, \quad [B] = \begin{bmatrix} 4 & 6 & -2 \\ 7 & 2 & 3 \\ 1 & 3 & -4 \end{bmatrix}, \quad [C] = \begin{bmatrix} -1 \\ 2 \\ 5 \end{bmatrix}
\]

\[
[A] + [B] = \begin{bmatrix} 4 & 11 & -2 \\ 15 & 5 & 10 \\ 10 & 1 & 5 \end{bmatrix}, \quad [A] - [B] = \begin{bmatrix} -4 & -1 & 2 \\ 1 & 1 & 4 \\ 8 & -5 & 13 \end{bmatrix}
\]
Solution (continued): compute $[A][B]$
Solution (continued): compute $[A]\{C\}$; Repeat similar steps to calculate $[A]\{C\}$. Use the formula $=\text{MMULT}(\text{B3:D5,L3:L5})$. 

Result for $[A][B]$ 

Result for $[A]\{C\}$
Example 14.9 – System of Linear Equations

Given: system of linear equations

\[
\begin{align*}
2x_1 + x_2 + x_3 &= 13 \\
3x_1 + 2x_2 + 4x_3 &= 32 \\
5x_1 - x_2 + 3x_3 &= 17
\end{align*}
\]

Find: \(x_1, x_2, x_3\)
Solution: The system of linear equations can be written into matrix form as shown.

\[
\begin{bmatrix}
2 & 1 & 1 \\
3 & 2 & 4 \\
5 & -1 & 3 \\
\end{bmatrix}
\begin{bmatrix}
x_1 \\
x_2 \\
x_3 \\
\end{bmatrix}
=
\begin{bmatrix}
13 \\
32 \\
17 \\
\end{bmatrix}
\]

The solution to this problem is discussed in detail in Chapter 18.
Example 14.9 – System of Linear Equations (continued)

Solution (continued): type the appropriate characters and values for [A], {B}, and {C}

\[
\begin{bmatrix}
2 & 1 & 1 \\
3 & 2 & 4 \\
5 & -1 & 3
\end{bmatrix}
\]

\[
\begin{bmatrix}
X_1 \\
X_2 \\
X_3
\end{bmatrix}
\]

\[
\begin{bmatrix}
13 \\
32 \\
17
\end{bmatrix}
\]
Example 14.9 – System of Linear Equations (continued)

Solution (continued): compute the inverse matrix of \([A]\)

Type the formula
\[=\text{MINVERSE}(B3:D5),\]
then while holding down the \textbf{Ctrl} and the \textbf{Shift} keys press the \textbf{Enter} key.

Select the range of cells where \([A]^{-1}\) will be displayed.

Type \([A]^{-1} = \)

© 2011 Cengage Learning Engineering. All Rights Reserved.

ENGR107 – Engineering Fundamentals
Example 14.9 – System of Linear Equations

(continued)

Solution (continued):

<p>| | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>1</td>
<td>1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>2</td>
<td>4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>-1</td>
<td>3</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

\[ [A] = \begin{bmatrix} 2 & 1 & 1 \\ 3 & 2 & 4 \\ 5 & -1 & 3 \end{bmatrix} \]

\[ \{X\} = \begin{bmatrix} X_1 \\ X_2 \\ X_3 \end{bmatrix} \]

\[ [B] = \begin{bmatrix} 13 \\ 32 \\ 17 \end{bmatrix} \]

\[ [A]^{-1} = \begin{bmatrix} 0.556 & -0.22 & 0.111 \\ 0.611 & 0.056 & -0.28 \\ -0.722 & 0.389 & 0.056 \end{bmatrix} \]

Result for \([A]^{-1}\)
Example 14.9 – System of Linear Equations (continued)

Solution (continued): solving for \{X\}

Type the formula
\[\text{=MMULT(B9:D11,K3:K5)}\],
then while holding down the Ctrl and the Shift keys press the Enter key.

Select the range of cells where the values of \{X\} will be displayed.

Type this:

\[\text{=MMULT(B9:D11,K3:K5)}\]
Example 14.9 – System of Linear Equations (continued)

Solution (continued): Final results

\[
\begin{align*}
\text{Answer: values of } x_1, \ x_2, \text{ and } x_3
\end{align*}
\]

<p>| | | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>2</td>
<td>1</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>3</td>
<td>2</td>
<td>4</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>5</td>
<td>-1</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

\[
\begin{align*}
[A] =  & \begin{pmatrix}
2 & 1 & 1 \\
3 & 2 & 4 \\
5 & -1 & 3 \\
\end{pmatrix} \\
X = & \begin{pmatrix}
x_1 \\
x_2 \\
x_3 \\
\end{pmatrix} \\
[B] = & \begin{pmatrix}
13 \\
32 \\
17 \\
\end{pmatrix}
\end{align*}
\]

\[
\begin{align*}
[A]^{-1} =  & \begin{pmatrix}
0.556 & -0.22 & 0.11111 \\
0.611 & 0.056 & -0.2778 \\
-0.722 & 0.389 & 0.05556 \\
\end{pmatrix} \\
\{X\} = & \begin{pmatrix}
x_1 \\
x_2 \\
x_3 \\
\end{pmatrix} = [A]^{-1}[B] = \begin{pmatrix}
2 \\
5 \\
4 \\
\end{pmatrix}
\end{align*}
\]
Curve Fitting with Excel

• Curve fitting deals with finding an equation that best fits a set of data
• More applications in numerical methods and other future engineering classes
Curve Fitting with Excel Procedures

- Plot data using steps described in previous sections
- With the mouse pointer over the data points, right-click the mouse button
- Select **Add Trendline**
- In Add Trendline dialog box
  - choose the **Trend/Regression** type desired
  - click the **Options** tab and toggle on
    - *Set intercept =*
    - *Display equation on chart*
Given: From Chapter 10, we learned that a spring force is given by the equation below. The force-deflection data are plotted as shown.

\[ F = kx \]
Example 14.10 – Curve Fitting (continued)

Find: use Excel to obtain an equation that best fits the data.

Solution: Use the XY (Scatter) plot (without connecting points to create the plot blow
Solution (continued): With the mouse pointer on the data points, right-click the mouse button. Then select Add Trendline.
Solution (continued): in Format Trendline,

Select Trend/Regression Type

Toggle Set Intercept = 0 and Display Equation on Chart
Solution (continued): Final display of trendline
Solution (continued): Final display of trendline

\[ F = 0.5542x, \text{ where } F = \text{load (N)}, \text{ and } x = \text{deflection (mm)} \]

Edit the equation as desired.
Solution (continued): comparison between the measured and predicted spring force is given below

<table>
<thead>
<tr>
<th>The Measured Deflection of the Spring, ( x ) (mm)</th>
<th>Measured Spring Force (N)</th>
<th>The Predicted Force (N) using: ( F = 0.5542 \times x )</th>
</tr>
</thead>
<tbody>
<tr>
<td>9</td>
<td>5.0</td>
<td>5.0</td>
</tr>
<tr>
<td>17</td>
<td>10</td>
<td>9.4</td>
</tr>
<tr>
<td>29</td>
<td>15.0</td>
<td>16.1</td>
</tr>
<tr>
<td>35</td>
<td>20.0</td>
<td>19.4</td>
</tr>
</tbody>
</table>
Example 14.11 – Curve Fitting

Given: a set of data points.

Find: the equation that best fits the data shown

<table>
<thead>
<tr>
<th>X</th>
<th>Y</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.00</td>
<td>2.00</td>
</tr>
<tr>
<td>0.50</td>
<td>0.75</td>
</tr>
<tr>
<td>1.00</td>
<td>0.00</td>
</tr>
<tr>
<td>1.50</td>
<td>−0.25</td>
</tr>
<tr>
<td>2.00</td>
<td>0.00</td>
</tr>
<tr>
<td>2.50</td>
<td>0.75</td>
</tr>
<tr>
<td>3.00</td>
<td>2.00</td>
</tr>
</tbody>
</table>
Solution: Plot the data as described in previous sections, with the mouse pointer on the data points right-click the mouse button. Then select Add Trendline (see Example 14.10 for more detail).
Example 14.11 – Curve Fitting (continued)

Solution (continued): in Format Trendline,

Select Trend/Regression Type

Toggle Display Equation on Chart and Display R-squared value on Chart
Example 14.11 – Curve Fitting (continued)

Solution (continued): The resulting quadratic curve, equation and $R^2$ value. $R^2$ is the coefficient of determination; $R^2 = 1 \Leftrightarrow$ a perfect fit, and $R^2 \approx 0 \Leftrightarrow$ an extremely poor fit.

![Graph showing a quadratic curve with equation $y = x^2 - 3x + 2$, and $R^2 = 1$.]
**Example 14.11 – Curve Fitting** (continued)

**Solution (continued):** comparison between actual and predicted \( y \) values

<table>
<thead>
<tr>
<th>( X )</th>
<th>Actual ( Y )</th>
<th>Predicted value of ( y ) using ( y = x^2 - 3x + 2 )</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.00</td>
<td>2.00</td>
<td>2.00</td>
</tr>
<tr>
<td>0.50</td>
<td>0.75</td>
<td>0.75</td>
</tr>
<tr>
<td>1.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>1.50</td>
<td>-0.25</td>
<td>-0.25</td>
</tr>
<tr>
<td>2.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>2.50</td>
<td>0.75</td>
<td>0.75</td>
</tr>
<tr>
<td>3.00</td>
<td>2.00</td>
<td>2.00</td>
</tr>
</tbody>
</table>
Summary

• You should know that a spreadsheet is a tool that can be used to solve an engineering problem
  – use a spreadsheet to present the results of an analysis in a chart form
  – input your own formulas
  – use the built-in functions provided by the spreadsheet

• You should know how to move around in a workbook and input into different cells.
• You should know how to edit the content of a cell.
• You should know how to select multiple cells and create a range.
• You should realize you can name a range and use the name in formulas or in plotting data.
• You should understand how to refer to a cell by its address.
Summary (continued)

• You should know the difference among a cell’s relative, absolute, and mixed address.
• You should know when to use the proper cell address when creating formulas.
• You should be familiar with Excel’s built-in functions.
• You should know how to insert cells, columns, and rows in an existing worksheet.
Summary (continued)

• You should know how to create a proper engineering chart using Excel.
• You should know how to perform matrix operations with Excel.
• You should know how to perform curve fitting with Excel.